Article Subject (see Index Terms below and write one here)	

Preparation of Papers for IEEE Sensors Letters (Revised November 2016)

First A. Author1,2, Second B. Author Jr.2*, and Third Author (第三著者)3,4**
1 School of Electrical Engineering, and Computer Science, The Pennsylvania State University, University Park, PA 16802, USA
2 National Institute of Standards and Technology, Gaithersburg, MD 20899, USA
3 Department of Mechanical and Aerospace Engineering, University of California, Irvine, CA 92697, USA
4 National Institute for Materials Science, Tsukuba, Ibaraki 305, Japan
* Senior Member, IEEE
** Fellow, IEEE

Received 1 Nov 2016, revised 25 Nov 2016, accepted 30 Nov 2016, published 5 Dec 2016, current version 15 Dec 2016. (Dates will be inserted by IEEE; “published” is the date the accepted preprint is posted on IEEE Xplore®; “current version” is the date the typeset version is posted on Xplore®).

Abstract—These instructions give you guidelines for preparing papers for IEEE Sensors Letters. Use this document as a template if you are using Microsoft Word. Otherwise, use this document just for helpful information, and prepare your paper using any word processor. LaTeX template currently being prepared. The Word template is useful for estimating the length of an article (up to 3½ pages of text plus an additional ½ page for references only will be allowed – total paper length not to exceed 4 pages). If you do not use the template, 4 journal pages have a total of about 3600 words; each figure is equivalent to about 140 words. The electronic file of your paper will be formatted further at IEEE. Paper titles should be written in uppercase and lowercase letters. Avoid writing long formulas with subscripts in the title; short formulas that identify the elements are fine (e.g., “Nd-Fe-B”). Do not begin a title with the word “On.” Avoid starting a title with articles like “The.” Full names of authors are much preferred over initials. Chinese, Japanese, and Korean authors are encouraged to include their names in native characters in parentheses after their Romanized names. More information may be found at www.ieee.org/publications_standards/publications/authors/auth_names_native_lang.pdf. Department names are optional in the affiliations. Do not give street addresses in the affiliations (except for authors with no institutional affiliation). Define all symbols used in the abstract, and again in the text. Do not cite references in the abstract.

Index Terms—Approximately four key words or phrases in alphabetical order, separated by commas. IEEE Sensors Letters accepts papers on sensors at all length scales including macro, micro and nanoscales. More details are available at mc.manuscriptcentral.com/sensors-letters. 
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This document is a Microsoft Word template for IEEE Sensors Letters. Use of this document as a template is optional. If you are reading a paper version of this document, please download the electronic Manuscript Template, from http://ieee-sensors.org/wp-content/uploads/2017/01/Sensors-Letters-Manuscript-Template-v-2.docx so you can use it to prepare your manuscript. If you would prefer to use LaTeX, download IEEE’s LaTeX style and sample files from the same Web page (currently under construction). Use those LaTeX files for formatting, but please follow the instructions in SENSL2016A.DOCX (or SENSL2016A.PDF).
When you open SENSORS LETTERS TEMPLATE V-2, select “Print Layout” from the “View” menu in the menu bar (View > Print Layout). Then type over sections of the document or cut and paste from another document and then use markup styles (Home > Styles). For example, the style at this point in the document is “Text L-SENS”). Highlight a section that you want to designate with a certain style; then select the appropriate name on the style menu. The style will adjust your fonts and line spacing. Use italics for emphasis; do not underline. The font used for the text Sensors Letters is Times Roman.
Even though a Letter is limited to 4 pages of text, please use up to two levels of section headings, which will improve the readability of most articles. 
To insert images in Word, position the cursor at the insertion point and either use Insert > Picture or copy the image to the Windows clipboard and then Home > Paste. IEEE will do the final formatting of your paper, so do not worry about precisely positioning figures and tables. If you have a question about formatting your paper, or a suggestion on improving these instructions, please contact s.tadigadapa@ieee.org.
PROCEDURE FOR PAPER SUBMISSION
ScholarOne® Manuscripts
Contributions to Sensors Letters must be submitted electronically on IEEE’s on-line manuscript submission and peer-review system, ScholarOne® Manuscripts, at https://mc.manuscriptcentral.com/sensors-letters. First check if you have an existing account. If there is none, please create a new account. (Please note that IEEE Sensors Journal and IEEE Sensors Letters use separate login credentials. Please set-up an account for IEEE Sensors Letters even if you have one for IEEE Sensors Journal) After logging in, go to your Author Center and click “Start a New Submission”.
Along with other information, you will be asked to select the subject (“Type”) from a pull-down list of two choices (i) Regular Letter or (ii) Perspectives Article. All submissions must be submitted as regular letters unless it is short article providing a perspective on a given topic. There are 7 steps to the submission process; you must complete all 7 for a complete submission. At the end of each step you must click “Save and Continue”; just uploading the paper is not sufficient. After step 7 you should see a confirmation that the submission is complete. You should also receive an e-mail confirmation. For inquiries regarding the submission of your paper on ScholarOne® Manuscripts, please contact oprs-support@ieee.org or call +1 732 465 5861.
ScholarOne® Manuscripts will accept files for review in the following formats: DOC, DOCX, RTF, PS, or PDF. PDF is preferred at the review stage. If you use LaTeX to prepare your document, you must generate a PDF or PS file to upload to ScholarOne® Manuscripts. Whatever format you upload, your figures should be embedded in the file.
You will be asked to file an electronic copyright form during the submission process. (Authors are responsible for obtaining any security clearances.) You will also have the opportunity to designate your article as “open access” in perpetuity if you agree to pay the IEEE open access fee. 
Final Submission
After your paper is accepted, you will be asked to upload final files to ScholarOne® Manuscripts. These will include your DOC, DOCX, RTF, or LaTeX document source file with embedded figures; an additional PS or PDF file if your source is LaTeX; and separate, individual figure files. These individual files may be in any of the following formats: TIF (preferred), PDF (preferred), JPG, GIF, EPS, DOC or DOCX (especially good for tables), or PPT (commonly used to make figures). Please convert your DOC or DOCX tables and PPT figures to PDF. Figure and table files should be named following this convention: FIG1.TIF, FIG2.PPT, FIG3.PDF, etc.
Designate the author who submitted the manuscript on ScholarOne® Manuscripts as the “corresponding author.” This is the only author to whom proofs of the paper will be sent.
ORCID Instructions
All IEEE journals require an Open Researcher and Contributor ID (ORCID) for all authors. ORCIDs enable accurate attribution and improved discoverability of an author’s published work. The corresponding author will need a registered ORCID in order to submit a manuscript or review a proof in this journal. Follow these steps to link a ScholarOne account to a registered ORCID:
· Login to ScholarOne and click on your name in the top right corner of the screen.
· Click E-mail/Name in the dropdown menu.
· In the ORCID section at the top of the page, click the appropriate link to either register for a new ORCID or associate the account with an existing ORCID.
· A new page will open to create and/or validate your ORCID. Once the validation is complete, the new page will close and you will return to ScholarOne.
· Save the changes to your ScholarOne user account. Authors who do not have an ORCID in their ScholarOne user account will be prompted to provide one during submission.
Publication
When the files for your accepted manuscript are all uploaded and checked by the Sensors Letters editorial office, your paper will be sent to IEEE, where it will be posted as a preprint on IEEE’s Xplore® platform, which will represent official publication. Thus, your final submitted manuscript should be a version you would like people to read. PDF page proofs will be sent by e-mail to the corresponding author in 2 to 3 weeks. The typeset article, with its article number, should appear on Xplore® a few days after the author approves the proofs.
HELPFUL HINTS
Editing Service
IEEE has partnered with SPi Publisher Services to offer pre-submission professional editing services to IEEE authors. SPi copyedits and typesets more than 1 million pages per year for over 600 journals. Authors who would like assistance with English grammar and usage prior to submitting their manuscripts for review or during the review process can go to www.prof-editing.com/ieee to submit a manuscript for copyediting. A link is provided on the ScholarOne® Manuscripts Web site. SPi copyeditors will edit for grammar, usage, organization, and clarity. Authors can use the service, at their own expense, as often as desired. Cost estimates are available on-line, typically about $100 for a four-page article. Edited manuscripts are generally returned to the authors within two weeks of submission.
Units
Use either SI (MKS) or CGS as primary units. (SI units are strongly encouraged.) English units may be used as secondary units (in parentheses). This applies to papers in data storage. For example, write “15 Gbit/cm2 (100 Gbit/in2).” An exception is when English units are used as identifiers in trade, such as “3½ in disk drive.” Avoid combining SI and CGS units, such as current in amperes and magnetic field in oersteds. This often leads to confusion because equations do not balance dimensionally. If you must use mixed units, clearly state the units for each quantity in an equation.
The SI unit for magnetic field strength H is A/m. However, if you wish to use units of T, either refer to magnetic flux density B or magnetic field strength symbolized as µ0H. Use the center dot to separate compound units, e.g., “A·m2.”
Figures and Tables
Most authors will be able to prepare images in one of the allowed formats listed above. No matter how you convert your images, it is a good idea to print the files to make sure nothing was lost in the process. For more information on graphics files, please go to www.ieee.org/publications_standards/publications/authors/authors_journals.html and click on the link “Using Microsoft Products or PDFs to Submit Graphics.”
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Fig. 1.  Resonance frequency as a function of time. Note that “Fig.” is abbreviated. It is good practice to explain the significance of the figure in the caption.

Because IEEE will do the final formatting of your paper, you do not need to position figures and tables at the tops and bottoms of columns. Large figures and tables may span both columns. Place figure captions below the figures; place table captions above the tables. If your figure has two parts, for example, include the labels “(a)” and “(b)” as part of the artwork. Please verify that figures and tables that you mention in the text actually exist. Please do not include captions as part of the figures. Do not put captions in “text boxes” linked to the figures. Do not put borders around the outside of your figures. Use the abbreviation “Fig.” even at the beginning of a sentence. Do not abbreviate “Table.” Tables are numbered with Arabic numerals.
Color Figures
There is no charge for color figures. Since Sensors Letters is electronic journal, color figures are automatically produced as part of the journal publishing. Please ensure proper choice of colors for unambiguous exposition of what is being shown. 
Figure axis labels are often a source of confusion. Use words rather than symbols. As an example, write the quantity “Pressure,” or “Pressure, P,” not just “P.” However, if there is not enough room on the axis to specify the quantity, write just the symbol “P,” but define it in the figure caption. IEEE allows two ways to designate units in graphs and tables: (1) Put units in parentheses. As in Fig. 1, for example, write “Intensity (W/m2)” or “Intensity, I (Wm2)” (but not just “W/m2”). (2) Label axes with a ratio of symbols and units. For example, write “Intensity, I/(Wm2)” or “Temperature, T/K” (but not “Temperature/K”).
Multipliers can be especially confusing. Write “Frequency (MHz)” or “Frequency (106 Hz).” Do not write “Frequency (Hz)  106” because the reader would not know whether the top axis label in Fig. 1 meant 83,125,000 Hz or 0.000083125 Hz. Figure labels should be legible, approximately 8 to 10 point type when reduced to journal column width.

Table 1.  Units for magnetic properties.
Symbol
Quantity a
Conversion from Gaussian and cgs emu to SI b

magnetic flux
1 Mx  108 Wb = 108 V·s
B
magnetic flux density, 
  magnetic induction
1 G  104 T = 104 Wb/m2
H
magnetic field strength
1 Oe  103/(4) A/m
m
magnetic moment
1 erg/G = 1 emu 
   103 A·m2 = 103 J/T
M
magnetization
1 erg/(G·cm3) = 1 emu/cm3
   103 A/m
4M
magnetization
1 G  103/(4) A/m

specific magnetization
1 erg/(G·g) = 1 emu/g 
   1 A·m2/kg
j
magnetic dipole moment
1 erg/G = 1 emu 
   4  1010 Wb·m
J
magnetic polarization
1 erg/(G·cm3) = 1 emu/cm3
   4  104 T

specific susceptibility
1 cm3/g  4  103 m3/kg

permeability
1  4  107 H/m 
  = 4  107 Wb/(A·m)
r
relative permeability
  r
w, W
energy density
1 erg/cm3  101 J/m3
a No vertical lines in table. 
b Gaussian units are the same as cgs emu for magnetostatics; Mx = Maxwell, G = Gauss, Oe = Oersted, Wb = Weber, V = Volt, s = second, T = Tesla, m = meter, A = Ampere, J = Joule, kg = kilogram, H = Henry.

References
Sensors Letters uses a numbered reference style, as in most other IEEE journals. Cite articles by number in square brackets [1]. The sentence punctuation follows the brackets. Multiple references are combined within brackets [1, 2] or [1-4]. When citing a section in a book, please give the relevant page numbers [7]. If the reference is part of the sentence, refer to the authors with the year in brackets, as shown by Eason et al. [3] and Jacobs and Bean [5]. Unfortunately, the IEEE document translator cannot handle automatic endnotes in Word; therefore, type the reference list at the end of the paper using the “References” style. An optional EndNote® style file for sensors letters is available here (http://endnote.com/styles/IEEE Trans Biomed Engineer.ens).For journal articles, please include the Digital Object Identifier if you can find it at www.crossref.org/guestquery.
In the reference list, give all authors’ names; do not use “et al.” Use a space after authors’ initials. Papers that have not been published should be cited as “unpublished” [4]. Papers that have been submitted for publication should be cited as “submitted for publication” [1]. (Since the paper may not be accepted, it is best to not specify the journal.) Papers that have been accepted for publication but not yet assigned to an issue should be cited as “to be published” [2]. Please give affiliations and addresses for private communications [6].
Capitalize only the first word in a paper title, except for proper nouns and element symbols. For papers published in translation journals, please give the English citation first, followed by the original foreign-language citation [8]. 
Abbreviations and Acronyms
Define abbreviations and acronyms the first time they are used in the text, even after they have already been defined in the abstract. Abbreviations such as “IEEE,” “SI,” “ac,” and “dc” do not have to be defined. Abbreviations that incorporate periods should not have spaces: write “C.N.R.S.,” not “C. N. R. S.” Do not use abbreviations in the title unless they are unavoidable (for example, “IEEE” in the title of this article).
Equations
If you are using Word, use either the Microsoft Equation Editor or the MathType add-on (www.dessci.com/en/products/mathtype) for equations in your paper (Insert > Equation). Fit the equation into one column by breaking it as you wish it to appear when typeset. You may find it convenient to create a new “equation” for each section of the equation.
Number equations consecutively with equation numbers in parentheses in the vicinity of the equation, as in (1). To make your equations more compact, you may use the solidus ( / ), the exp function, or appropriate exponents. Use parentheses to avoid ambiguities in denominators. Punctuate equations when they are part of a sentence, as in


(1)




The font for symbols should be similar to Times Roman. Use the “Symbol” style. Be sure that the symbols in your equation have been defined either before the equation appears or immediately following. Italicize symbols (T might refer to temperature, but T is the unit Tesla). Refer to “(1),” not “Eq. (1)” or “equation (1),” except at the beginning of a sentence: “Equation (1) is ... .”
Please confine equations to one column width and break equations at appropriate algebraic symbols.
Supplementary Information
Authors may not include any supplementary information. The journal’s rapid-publication model requires short articles that can be reviewed relatively quickly and no supplementary material is allowed.
CONCLUSION
A conclusion section is not required. Although a conclusion may review the main points of the paper, do not replicate the abstract in the conclusion. A conclusion might elaborate on the importance of the work or suggest applications and extensions. 
An excellent style manual and source of information for science writers is [9]. A general IEEE style manual is available at www.ieee.org/publications_standards/publications/authors/authors_journals.html. (The style for Sensors Letters differs in many respects.)
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